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Compiere 3.3 Release Summary 

Compiere 3.3 is a major release that adds more than 35 new functional, technical and business analysis enhancements. This new 
release continues Compiere‟s commitment to building open source applications that drive down costs and complexities of ERP. 
Visit http://www.compiere.com/products/new-compiere-erp-3-3.php to learn more about the Compiere 3.3 benefits. 

Certain features in Compiere 3.3 require a Compiere Professional Edition subscription. Contact a Compiere Authorized Partner or 
Compiere Sales (http://www.compiere.com/company/contact-us.php) to acquire Compiere Professional Edition.  

Compiere 3.3 may include certain prototype features and beta functionality as indicated in their respective user interfaces with a 
beta checkbox.  These are not recommended for production. They are intended only for evaluation as beta functionality. 
Audience 

This guide is designed for Compiere Business Partners and Customers. It provides essential information for current Compiere 
administrators planning to install or migrate (upgrade) to Compiere 3.3. 

  Prerequisites 

 Working knowledge of Compiere ERP and CRM 

 Compiere Web Store Access 

 Sun Java JDK 1.6.0 Update 5 or Later 

 Database Oracle XE, Oracle 10gR2, Oracle 11g, or 
EnterpriseDB Postgres Plus Advanced Server 8.3 

 

Software Management 

  Previous Installations 

You can download the Compiere 3.3 from http://www.compiere.com/wstore. The migration tool will bring you up directly to 

Compiere 3.3 plus all the cumulative fixes included in the service packs without having to migrate to an intermediate release. 

  Recommended Infrastructure 

 Sun Java JDK 6 Update 5 or Later (not just JRE)  
- also known as Sun Java SDK. 

 Database Oracle XE, Oracle 10gR2, Oracle 11g, or 
EnterpriseDB Postgres Plus Advanced Server 8.3. 

   Tip: It is Mandatory to use a Unicode character set.  

 Database approved Linux Operating System, Windows 
2003 or Windows XP 

 TCP/IP connection and Internet access 

 Disk Space: > 5 GB (includes database)  

 Swap Space: > 1GB 

 Memory: > 1 GB  

 Firefox Browser 3.0 is recommended for Web User 
Interface. 

  Process to Log Support Requests 

To ensure timely service for any issues, please use the Compiere's Case Management system. For details please review the 
Support Requests page on our website. 

  Update/Migration Procedure 

See Appendix A 

  Install Procedure 

See Appendix B 

  Application Extensions 

See Appendix C 

  Command Line Scripts 

See Appendix D 

 

http://www.compiere.com/products/new-compiere-erp-3-3.php
http://www.compiere.com/company/contact-us.php
http://www.compiere.com/wstore
http://www.compiere.com/support/support-requests.php


 

 Copyright © 2009 Compiere Inc. – All rights reserved  4 

New In Compiere 3.3 
The following is a detailed description of the enhancements made available in Compiere 3.3. 

 Grid Functionality and Tab Navigator                       Compiere Professional Edition 
Compiere 3.3 provides the ability of table inline editing behavior in the Web UI to make it behave more like a Excel 
spreadsheet. Users can add and modify records in grid mode without having to go into single record view. This also 
provides easy navigation between tabs. 
 

      Few highlights: 
1. Single click to highlight one cell to be edited. Double click to edit the cell 
2. Use keyboard up, down, left, right, tab to navigate through cells 
3. F2 to switch between “Edit” and “Enter” mode. The difference between those mode is that in “Enter” mode the 

arrow keys would take the user out of the editing, while in “Edit” mode arrow keys are treated as editing keys 
 
      Tab Navigation:  

Breadcrumb behavior between window/tabs has been modified to provide easy navigation. Breadcrumbs in 
general are clickable. Breadcrumbs with underline are clickable and mouse over breadcrumb that is not 
underlined will pop up the menu for other tabs (if there are any). For example: In Business Partner window, when 
you update the customer information and also want to update the contact (user), you mouse over the Customer 
tab on the top and select the tab you want to update. 

 

  Report Enhancements                                               Compiere Professional Edition 
Compiere 3.3 provides the ability to create adhoc reports. My Reports UI has been enhanced to show Reports as     
Tree nodes under the menu tree. A Report Editor is also provided so that users can Edit the Report Print Format‟s 
and create new ones. User can also run the Report as and when making changes to the print format. 

 

 New Reports                                                                Compiere Professional Edition 

      Compiere 3.3 provides 25 newly created reports. Following is the detailed description of new reports available in 3.3. 

 

      

Functional Area Report Name Description 

Order 
Management Sales Order Summary What are my sales orders? 

  Sales Order Detail What products did my customers buy? 

  Open Orders What are my open orders? 

  Sales by Invoice Date What are the sales of each product based on date invoiced? 

  
Sales by Product Category 
Summary What are the sales of each product in a product category? 

  
Sales by Product Category 
Detail 

What are the sales of each product in a category and what 
was the invoice amount? 

  
Sales by Product Category 
and Customer 

What are the sales of each product in a category and how 
much has each customer spent on it? 

  Sales by Customer Detail 
What are the sales of each product and how much has each 
customer spent on it? 

  Cash Journal Detail Detail Cash Journal Information 

Procurement Purchase Order Summary What are my purchase orders? 

  Purchase Order Detail What products or services did we buy? 

  Purchases by Invoice Date What products did we purchase based on the date invoiced? 

  
Purchases by Product 
Category Summary What products did we purchase in every product category? 

  
Purchases by Product 
Category Detail 

What was the invoice amount on purchases of products from 
each vendor by product category? 

  
Purchases by Product 
Category and Vendor 

How much did we spend on purchases of products from each 
vendor by product category? 
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Purchases by Vendor 
Detail 

How much did we spend on purchases from each vendor and 
what products did we buy from them? 

Material 
Management Product List What products do we have in our facility? 

  Storage Detail Storage Detail Report 

Financial 
Management 

Transaction Detail by 
Account 

What are the transactions for each account by business 
partner? 

  Accounting Entries by Date 
What do my accounting entries look like for a date range or 
period? 

Partner 
Relations 

Business Partner Contact 
List What is my business partner's contact information? 

  
Business Partner's Mailing 
List What is my business partner's mailing information? 

Requests Support Requests What are the support requests by status? 

Customer 
Assets Customer Assets What are my customer's assets? 

System 
Administration List of Reports Create a list of all the reports in the system 

 

 

 Compiere on Amazon EC2                                                      Compiere Cloud Edition 

Compiere Cloud Edition is a comprehensive business application that is deployed on Amazon‟s cloud computing 
environment. Compiere Cloud Edition is based on the comprehensive Compiere Professional Edition which 
automates processes from Accounting, Purchasing, Order Fulfillment, Manufacturing, Warehousing and CRM. The 
combination of Compiere Cloud Edition and Amazon‟s EC2 platform provides convenience of utility computing, 
comprehensive functionality, flexible deployment, and reduces the cost of ERP deployment by eliminating up-front 
capital costs for hardware and software, while also reducing ongoing IT infrastructure support costs. For more details 
about Compiere Cloud Edition, please visit http://www.compiere.com/products/cloud-edition.  

Compiere Partners may offer Compiere Cloud Edition by participating in a short web-based training class and 
achieving Compiere Cloud Edition partner certification. 

 

 

  Additional Enhancements  Compiere Professional Edition 

 Work Flow Editor – A form available from the Main Menu used to create or modify a Workflow. 

 Accounting Dimensions – Windows used to set up Account structure.  

 

 Technical Enhancements  All Compiere Editions 

 New command line scripts to install migrate or update the license of your instance. For details see appendix D. 

 For customers using Oracle database, we have migrated from our Compiere cache implementation to the Oracle 
JDBC connection cache implementation for Data Source. This should improve performance, especially for the 
Professional Edition, by better using the cache of physical database connections.  

 For customers using Oracle database, we have also upgraded to the Oracle JDBC driver version 11.1.0.7. This 
driver is certified by Oracle against databases 10gR2 and 11gR1. 

 Since Compiere 3.2.1 we are using JBoss Application Server version 4.2.3. For details see JBoss release notes 

 

 

http://www.compiere.com/products/cloud-edition
http://sourceforge.net/project/shownotes.php?release_id=614346&group_id=22866
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    The Web User Interface in Compiere 3.3 

     The following is a detailed description of what the Web user interface has to offer in Compiere 3.3 

  Web User Interface Compiere 3.3  Compiere Professional Edition 

 In order to get properly acquainted with the Web User Interface, please read the section on “Using the Web    
Application” in the user documentation.  

At present, there are still some known features available in the “Java Swing” User Interface that are not yet      
available in Web User Interface. Most of these features are scheduled for a future release. 

The following features are currently Not Available in the Web User Interface. However, they are fully functional   
in the “Java Swing” User Interface: 

 Resource & Schedule Info Windows – Info Window available from the „View‟ menu to view Scheduled Resources. 

 Resource Assignment – A Form used to schedule a resource accessed from the Assigned Resource field in a 
Sales Order, Project, or Expense Report.  

 Personal lock – A security feature accessible from the toolbar used to lock a specific record to keep the record 
private. It is also used as a method to set security access rules for specific records.  

 Archive Viewer – A window used to view the Archived Records.  Records or Documents can be archived via the 
toolbar from the document viewer or automatically via a setting available in the tenant window.  

 Ability to print mass shipments – A process available from the Main Menu used to print multiple shipments.  

 Print from info windows – A button accessible from any Info window used to print a screen shot of the information. 

 Drill down on reports – Interactivity on Reports which enables you to view a different report from a drill menu 
where a selected record is used. 

 Ability to email documents/reports as attachment – A button available from the toolbar of any report or document 
that opens an e-mail dialog box with the report attached as a .pdf file allowing users to send the report via e-mail.  

 Product attribute grid – A form available from the Main Menu which allows users to select an Attribute and view a 
grid of which products are available with the selected attributes.  

Important: The Firefox Browser 3.0 is recommended when using Compiere Release 3.3 with the web user interface.  

When using Internet Explorer 7.0, verify the options: “Always switch to new tabs when they are created” and “A new tab in 
the current window” are enabled: Under Tools> Internet Options> General Tab, open the Tab settings.  
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 Fixed Issues for Compiere 3.3 

The following is a list of the customer issues that have been fixed in Compiere 3.3. 

Compiere 
Case Number 

Description 

10016066 When logging in as language en_ZA or english(UK) -- the print option is selected the date format is 
MM/dd/yyyy for the printed document, contrary to the format on the window. 

10016582 Charge: amount not used in Sales Order 

10018003 When the workflow or workflow node responsible is set to Organization it does not get routed to the 
supervisor defined for that organization. The workflow stays in a suspended status but is not 
designated as a task for any user to complete. 

10018211 Unable to install when using a print format attached to a process 

10018261 Web UI :Log in as GardenAdmin, create a new Role and defined it as Access Level 'Organization'; 
Access to all Orgs FALSE and Use User Org Access TRUE. Create a new User linked to that Role 
and linked to Organisation 'Store'. Log in with this new user, go into Business Partner or Sales Order 
Screen : the 'Tenant' field has disappeared.  In 'Organisation Field' I can only choose * 

10018817 Tree navigation: When you drag nodes (for example drop a new child node into an existing summary) 
the whole tree collapses. You have to manually navigate back to the correct point in the tree. 
When you switch tabs, for example to look at child records of the current record, and then return to 
the tab that contains the tree the tree is collapsed. This can be seen in the "Account Element" 
window, with the "Element Value" and "Sub Account" tabs. 

10019057 When placing a purchase order on a warehouse, the "On Order" qty gets increased. If the Material 
Receipt matched to that PO is for a different warehouse, then the On Order qty is reduced on the 
wrong warehouse. 

10019246 Web UI - Business Partner > Bank Account Tab, if a ACH selected and a bank chosen, the Account 
No field is moved to a third column. There should only be 2 columns. 

10019248 Web UI Shortcuts - Ctrl-M (new line) doesn't work in any window that has child tabs (e.g. Business 
Partner window). 

10019281 InfoColumns is not translated. Because synchronize terminology does not update it. 
Besides Infowindow titles menu are not translated. 

10019351 Accounting consequences. There is no minus sign in accounting. But Compiere sometimes treat 
specific accounting consequences with minus rather than with debit or credit place. 

10019492 Payment Selection - Create From.  If I have invoices in 2 or more organizations, the "Create From" 
process will add these all invoices to the current payment selection. Hence the organization linked to 
the current payment selection is paying the invoices for all other organizations.  

10019619 WebUI : Callout issue. When you update a field, sometimes the Callout linked to that field is not run 
if You type the value of the field, then type the ENTER key then Save 

10019636 WF Activity panel: message not cleared between activities 

10019757 Web UI. When using Import File Loader to import orders, the process fails to process csv files 
correctly that have more than 6003 lines in it.  

10019788 Web UI: On the Sales Order window zooming on the Related Order field opens the original order and 
not the related order. The Swing UI works correctly. 

10019795 Both interfaces-With a role defined for access all orgs, bank account (as used in Payment Selection 
and Payment Selection manual does not display all appropriate banks.  When org access is explicitly 
defined for the role it works properly 
It does not matter if the data access level is set to Tenant & Organization or just Organization 

10019798 Role record access on virtual columns: 
If a role have record access rule with "Dependent Entities" selected, and the accessed table contain 
the column as ColumnSql, the generated select SQL is wrong. 

10019829 Payment Allocations - if a payment allocation is linked to an invoice with an amount at zero value, 
then the accounting consequence posting doesn't occur. It displays an error message indicating that 
the invoice hasn't been posted even though the invoice has been posted and the payment posted at 
zero value. Invoice has to be in a different currency to the base currency. 

10019835 Default logic 2 doesn't work with HTML UI :. 

10019852 Performance for importing a 10,000 purchase order is excessively long (25 minutes) both in SWING 
and WebUI. 

10019926 Unable to start Compiere Apps Server as a service 

10020048 Task Window: The wave field is not being populated. 

10020049 Warehouse Task window: The Shipment/Receipt field is not being being displayed and populated for 
Material Putaways. This is inconsistent with Shipments.  
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Compiere 
Case Number 

Description 

10020052 Wave Release window. 
1) If a Warehouse is chosen, the Wave drop down list gives a list of all waves for all warehouses. It 
should only give waves for the specific warehouse.  
2) Waves that have already been released are shown in the drop down list. Only Waves that are 
unreleased should be displayed. 

10020115 Product Based Receipt. When entering lines in the Grid Mode only, get the following errors: 
1) Once all lines have been entered and saved, there is no active Create Receipts button in grid 
view. A user needs to go into Edit mode and then the Create Receipts button is enabled.  
2) One Create Receipts has been run in grid mode, only the current line is updated with Receipt 
Number, Receipt Created, etc. A re-query is required to update all lines. At the end of the Create 
Receipt process can a requery on all records in the grid view be performed? 

10020117 Warehouse Management Workbench: Can the "Locator" field: 
1) Be renamed to "Fallback Locator" or something similar, 
2) The "comment" and "description" of the field improved to described what it does. Currently the 
they indicate that it is a "warehouse locator" and doesn't describe that it is used when a putaway 
locator can't be found. 

10020170 Edb specific:  When I select a BOM product in a sales order>Order line tab, it is throwing the error. 

10020178 EDB: Compiere comes back with the message that product or component is not on the pricelist (On 
order-header, pricelist Standard is selected) 
 

10020240 Wave Planning Window: Get a java null point and no wave generated error when trying to generate a 
wave with the following conditions: Generate Pick List : Yes, Print Pick List: Yes, Document Action: 
Prepare 

10019919 Performance and locking issues while completing invoice. 

10019791 If I create a new CAR-File for our extension via "Create Application File" I get some stack traces 
during this process. It's a problem with M_RecentItem. The log is attached for more details. Seems 
not to be critical because the extensions are working but maybe it is interesting to know. 

10019584 Tree maintenance: does not take security by organization into account. 

10019037 Roles having access to print formats without considering security by organization 

10020007 Printing from Dunning Run window -> Entry tab does not work correctly 

Product Enhancements for Compiere 3.3 

The following is a list of the enhancement Requests that have been completed in Compiere 3.3. 

Product 
Enhancement 

Description 

10020036 Warehouse Tasks: For Material Putaway tasks the Order line field is not populated. It is populated for 
Material Pick tasks. 
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Known Issues in the Migration Process 

Warnings and Error Messages you may see during the Migration steps. 

 
Migration Issues – Warning/Error Messages Database Comments 

ORA-00001: unique constraint... violated All 

This might indicate 
referential issues in 
your pre-migration data. 
Review the problem 
data. 

ORA-01408: such column list already indexed  All 
This is an acceptable 
warning message. 

ORA-01440: column to be modified must be empty to decrease precision or scale All 
This is an acceptable 
warning message. 

ORA-02296: cannot enable All 
This is an acceptable 
warning message. 

ORA-02275: such a referential constraint already exists All 

This might indicate 
referential issues in 
your pre-migration data. 
Review the problem 
data. 

ALTER TABLE S_ResourceType MODIFY ChargeableQty NUMBER(10) DEFAULT NULL  
Failed sql statements  
ERROR: cannot alter type of a column used by a view or rule  
Detail: rule _RETURN on view rv_asset_delivery depends on column "lot" - ALTER TABLE 
A_Asset_Delivery ALTER Lot TYPE  VARCHAR(255) , ALTER Lot SET DEFAULT NULL 

EnterpriseDB This is an acceptable 
warning message. 

No Key & No Parent - Table AD_RecentItem All This is an acceptable 
warning message 

While executing RUN_Setup, refreshing an existing instance 
===========> DB_PostgreSQL.getDataSource: DB_EnterpriseDB[null] [12] 
java.lang.IllegalArgumentException: DataSource with name 'CompiereDS' already exists! 

EnterpriseDB This is an acceptable 
warning message 

While executing RUN_Setup 
-----------> ModelValidationEngine.addClasses: GardenWorld: compiere.model.MyValidator 
- java.lang.ClassNotFoundException: compiere.model.MyValidator [12] 
-----------> ModelValidationEngine.addClasses: Extended Units of Measure: 
org.compiere.xuom.XUOMModelValidator - java.lang.ClassNo 
tFoundException: org.compiere.xuom.XUOMModelValidator [12] 

All This is an acceptable 
warning message 

ORA-01452: cannot CREATE UNIQUE INDEX; duplicate keys found 
 - CREATE UNIQUE INDEX AD_PrintformatItem_Unique ON AD_PrintFormatItem 
(AD_PrintFormat_ID,Name) 

All Migration of additional 
components (.car) with 
print format items won‟t 
work as expected. 

 

Known Issues in the Install Process 

Warnings and Error Messages you may see during the Import steps. 
 

Install Issues – Warning/Error Messages Database Comments 

-----------> g.a: DROP SEQUENCE T_Spool_Seq 
-----------> g.a: ORA-02289: sequence does not exist 

All 
This is an acceptable 
warning message. 

-----------> DB_PostgreSQL.convertStatement: Convert error! Converted statement 
Number=2 (CREATE OR REPLACE VIEW … 

EnterpriseDB 
This is an acceptable 
warning message. 

-----------> DB.saveError: DBExecuteError - ORA-00001: unique constraint 
(COMPIERE.C_REGION_NAME) violated 
 [15] 
-----------> MRegion.saveNewInsertSQL: Not inserted - C_Region [15] 
-----------> ProgressPanel.publish:    Unable to import Region, requires UNICODE database 
[15] 
===========> DB.executeUpdate: INSERT INTO C_Region 
(AD_Client_ID,AD_Org_ID,C_Country_ID,C_Region_ID,Created,CreatedBy,Description,Is
Active,IsDefault,Name,Updated,UpdatedBy) VALUES (0,0,216,438,TO_DATE('2006-02-23 
15:43:34','YYYY-MM-DD HH24:MI:SS'),0,'???(Miyasaki)','Y','N','???',TO_DATE('2006-02-
23 15:43:34','YYYY-MM-DD HH24:MI:SS'),0) [null] [15] 
java.sql.SQLException: ORA-00001: unique constraint 
(COMPIERE263.C_REGION_NAME) violated; State=23000; ErrorCode=1 
 at oracle.jdbc.driver.DatabaseError.throwSqlException(DatabaseError.java:125) 
 at oracle.jdbc.driver.T4CTTIoer.processError(T4CTTIoer.java:305) 

All 

These are acceptable 
if your database is not 
set for Unicode. 
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Install Issues – Warning/Error Messages Database Comments 

 at oracle.jdbc.driver.T4CTTIoer.processError(T4CTTIoer.java:272) 

At the very end of the install process or when manually executing utils/RUN_Support 
13:07:55.094 Compiere.startup: Client lap-fr/10.104.139.177: C:\Compiere2 - Java 
HotSpot(TM) Client VM 1.5.0_11-b03 - Windows XP 5 
.1 Service Pack 2 [15] 
Exception in thread "AWT-EventQueue-0" java.lang.NullPointerException 
        at 
javax.swing.plaf.basic.BasicScrollBarUI.layoutHScrollbar(BasicScrollBarUI.java:676) 
 

All No effect on the 
functionality. You may 
ignore this error. 

Error after clicking Save on the RUN_Setup window 
===========> CConnection.createConnection: jdbc:oracle:thin:@//lap-fr:1521/xe, (1) 
AutoCommit=true,TrxIso=READ_COMMITTED - ORA-010 
17: invalid username/password; logon denied 
 [12] 
-----------> CPreparedStatement.<init>: ALTER TABLE AD_System MODIFY Summary 
NVARCHAR2(2000) [12] 
java.lang.UnsupportedOperationException: No DBConnection 
        at org.compiere.util.DB.getConnectionRW(DB.java:228) 

All No effect on the 
functionality. You may 
ignore this error 

Error installing the sample application extension XUOM 
Failed sql statements: 
ORA-00955: name is already used by an existing object 
 - CREATE INDEX M_Product_ProductCategory ON M_Product (M_Product_Category_ID) 
- java.sql.SQLException: ORA-00955: name is already used by an existing object 

All This is an acceptable 
warning message 

Error installing the sample application extension XUOM 
Create Views  ****************************************** 
Starting to create views for entity: XUOM 
            Created view #1 for entity: XUOM 
Failed sql statements 
<<ERROR:   ERROR: relation "m_product_expensetype" already exists - CREATE  
UNIQUE INDEX M_Product_ExpenseType ON M_Product (S_ExpenseType_ID) -  
java.sql.SQLException: ERROR: relation "m_product_expensetype" already  
exists>> 
… same error for other indexes… 
<<ERROR:   ERROR: constraint "fk208_10919" for relation "m_product" already  
exists - ALTER TABLE M_Product ADD CONSTRAINT FK208_10919 FOREIGN KEY  
(C_SubscriptionType_ID) REFERENCES C_SubscriptionType  
(C_SubscriptionType_ID) - java.sql.SQLException: ERROR: constraint  
"fk208_10919" for relation "m_product" already exists>> 
…same error for other constraints… 

All This is an acceptable 
warning message 



 

 Copyright © 2009 Compiere Inc. – All rights reserved  11 

Known Issues in Compiere 3.3 

Issues you may encounter using Compiere 3.3 

Issue Database Solution 

Web UI: After running a large report in Firefox, the user may get a message that “The File 
is damaged and could not be repaired”. The workaround is to save the PDF on your 
machine using “File->Save Page As” in the Firefox window, and then opening the PDF. 

 

  

Web UI: Description is not available in workflow editor. Process requisition workflow. 

You should be able to see the description (ex: {10: Total Lines >100} 
  

Web UI: When any of the Workflow Review (i.e. Initial Tenant Setup Review) windows are 
displayed and then the menu tree is expanded over the workflow review, the icons for the 
steps in the workflow overwrite the menu options. 

 

  

Web UI: There is no button Panel at the bottom of the page for workflow Navigation in 
workflow editor window. 

  

Help window logged in with different language pack shows up in English.   

Warnings/errors in the JBoss server log 

--- Packages waiting for a deployer --- 

org.jboss.deployment.DeploymentInfo@d77f6fbd { 
url=file:/Compiere2/jboss/server/compiere/deploy/ejb3-interceptors-aop.xml } 

 

WARN  [org.jboss.ejb.txtimer.EJBTimerServiceImpl] Cannot obtain the implementation of a 
PersistencePolicy, using NoopPersistencePolicy: java.lang.RuntimeException: Error 
creating MBeanProxy: jboss.ejb:service=EJBTimerService,persistencePolicy=database 

 
This is an acceptable 
warning message 

 

For a current list of open issues please query the list of public requests from our request system 
http://www.compiere.com/support/support-requests.php. 

http://www.compiere.com/support/support-requests.php
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Compiere 3.3 Migration Instructions   

  Prerequisites 
 

- A valid Support contract 
- Sun Java JDK 6 (SDK) – Update 5 or later (not just JRE) 
- Database Oracle XE, Oracle 10gR2, Oracle 11g or EnterpriseDB Postgres Plus Advanced Server 8.3. 

 

 

 
 
 
 
 

  Preserving Customizations 

Compiere will not modify any customizations - as long as the customizations are marked appropriately! By default, all 
added records in the dictionary will have the entity type "User Maintained": 

 

- In the Change Audit window, mark the changes as Customizations before running the migration.  
   Tip: Alternatively, changes may be applied manually. 

- Before performing the migration, run it in the test mode to ensure all customizations will be preserved. 

 

  Migration Steps 

Migration Consists of the Following steps: 

 Preparation 

 Test Mode 

 Migrate to a New Release 

 Post Migration Steps 

http://www.compiere.org/migrate/changeAudit.jpg
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  Preparation  

Use the following steps to prepare for the Migration: 

 Server needs to have access to the Internet. 

 Stop the application server by executing 
utils/RUN_Server2Stop  

 Backup the database 

 If you are running EnterpriseDB 8.2 or older you 
must upgrade to EnterpriseDB Postgres Plus 
Advanced Server 8.3 

 Rename COMPIERE_HOME/jboss directory 

 Delete 
COMPIERE_HOME/data/compiere_'CPRO'.car file 
(filename including single quotes) 

 Delete 
COMPIERE_HOME/data/compiere_'XUOM'.car file 
(filename including single quotes) 

 Test Mode (optional) 

First, run the Migration Program in Test mode. This allows the ability to evaluate the actions taken when running it against 
the database. Please note that the first step (resolve ID conflicts) will not show the correct future IDs in test mode. 

If the program marks certain wanted tables for deletion, then create the table in the data dictionary (Window 
Table/Column) with the Entity Type User or Application. 

If the program marks certain wanted columns for deletion, make sure that the column has the Entity Type User or 
Application. If the wanted column has the Entity Type Data Dictionary or Compiere and it is marked for deletion, then copy 
it under another name and mark the new column as Custom or Application. 

The same applies to windows, tabs, fields, etc. 

Mandatory User or Application Columns must have a default value defined in the database, e.g. ALTER TABLE 
someTable MODIFY (myColumn DEFAULT 'myDefault'), otherwise adding new records will result in an error. 

 

Check List: 

 Server has HTTP (port 80) access to the Internet  

 Compiere web store  Asset - Support Contract  

System Operation Steps: 

 Resolve ID Conflicts from Customizations/Extensions  

 Synchronize Data Structure (Table/Column/Index/Constraints/..)  

 Synchronize Data Content 

 

  Migrate to a New Release 

Use the following steps on the Application Server box for migrating to the new release: 

1) Be sure to delete or rename the existing jboss subdirectory (due to different JBoss version and configuration 
files.) Download and unzip/untar the distribution file, (e.g. Compiere_3XX.X.zip.) 
 
Tip: It is also possible to extract the distribution file into a new directory and copy your configuration files. 
Then change the COMPIERE_HOME environment variable to the new directory. 

2) Execute RUN_setup. Verify all your environment settings and click Save to continue. If you get any errors in 
the parameters validation, you‟ll see a red icon right next to the parameter with the problem; make the 
required changes, click Test to run the validation again and then click Save to continue. 
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                     Note: The screen shots show version 3.2.0_Beta but these also apply for 3.3.  

 

 

3) The Compiere Public License Opens. Click “Yes, I Understand and Accept” to continue.  
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4) The following prompt will display describing your new Security Key. Click „Ok‟ to continue. 

 

5) The Next step is to provide the Subscriber Information. Current customers should provide the subscriber 
information (System Name, Email and Password) exactly as it was registered in the Compiere Web Store to 
get a complete list of applications. 
 

Click Check Available Applications to get a list of applications that are available to be installed. 

 
 

Note: To install additional applications once you have installed or migrated to the latest Compiere Core version, 
you must select Compiere Core plus any additional applications to install, and then run Migration. 

 

6) Select the applications that you want to migrate and select the action Reinstall/Migrate. Compiere Core 3.0 is 
the main application that must always be installed or migrated to the latest release, but you also may choose 
additional applications provided by Compiere or any of our authorized partners. 
 
Tip: If you do not wish to install or migrate any of the applications listed, be sure to change the action to –
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None- To install new applications change the action to New Install 

 

 

 

7) Next, read and accept the Compiere Public License agreement.  
Hint: You might get more than one license agreement, depending on the applications that you are installing. 
Notice that XUOM is a sample application extension 
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8) If you are installing Compiere Professional, you will receive a Commercial license agreement. Please read 
and accept the license agreement, in order to continue. 
Hint: You might get more than one license agreement, depending on the applications that you are installing. 

 
 

9) Click on Start File Installation 
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10) When the File Installation has completed click on Start Migrate Database. 
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11) Provide the following information exactly as it was registered in the Compiere Web store and click Check 
License to validate your asset information (Note: This information may already be populated if it was entered 
in the system window) 

- System Name 

- Registered Email 

- Password 

 
 
Tip: If you get the “Core Invalid” error after selecting the „Check License‟ button, that is an indication that you 
did not select the appropriate action for the Core component in step #5. In this case, Exit the setup and 
support windows and execute RUN_setup again selecting the Core plus any other components to install. 

12) Click on “Start Migration”. 
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13) At the Compiere Version Migration Prompt, click “Yes” to proceed with the Migration.  

 
 

14) Unselect the “Test Only” option, and click Start.  
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15) Confirm that you have a current back up of your database 

 

16) Confirm that the Source and Target database versions from the Compiere Version Migration window are 
correct. 

 

17) Verify that the migration finish with no errors and the message “After Migration - DONE” is displayed. In case 
you get any errors, please be sure to review the list of known issues listed in this document before logging a 
service request. 
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18) Verify the following log files for errors: 
a. migrate_2009_mm_dd_hh_mi_ss.log: complete log 
b. migrate_2009_mm_dd_hh_mi_ss.err.log: subset of log with just errors 
c. 2009-mm-dd_#.log: possible additional errors not printed to the migration log. (search for the file with the 
text "Compiere Migration 3.3") 

19) If you have a Compiere Professional Edition license, execute utils/RUN_Support and click “Check License” 
to activate your license.  
Tip: There is no need to click the start migration button. 

 

20) After you have pressed the Check License button you should be able to see if your Professional License has 
been activated. 

 

21) After Compiere Professional license has been updated you may click the “X” to close the window.  
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Hint: It is NOT necessary to click the Start Migration at this point.  

22) Start the Apps Server using the script utils/RUN_Server2 

23) To start Compiere in the Web UI after migration, it is required that all Web UI users clear their browser cache 
first. 

Note: After migration, (re-) apply the language packs when needed.  
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  Post Migration Steps for RMA/RTV 

This step is only relevant if you plan to use the new returns functionality and you are migrating from 2.6.3 or older. 
 

Compiere now has explicit return transactions. We discontinued the previously seeded "Return Material" functionality. 

In the "Document Type" window you need to do the following for every Tenant/Client: 

 

1) Delete or de-activate the document types 

 Return Material 

 MM Customer Return 
Hint: This is discontinued functionality 

 

If you choose to deactivate the obsolete document types (as opposed to deleting them), please rename the document 
type 'MM Customer Return' to an alternate name (For eg., ' ** MM Customer Return ** Do Not Use **') so you can 
successfully create the new document types detailed below. 

 

2) Create Return Document Types  

 MM Vendor Return 

- Copy "MM Receipt" and set Name 

- Select Return Transaction 

- De-Select Counter Document flags 

- Optionally select Confirmations 

 

 Vendor RMA  

- Copy "Purchase Order" and set Name 

- Select Return Transaction 

- De-Select Counter Document flags 

 

 MM Customer Return 

- Copy "MM Shipment" and set Name 

- Select Return Transaction 

- De-Select Counter Document flags 

- Optionally create a special Document Sequence and or Confirmations 

 

 Customer RMA (Copy Standard Order 

- Copy "Standard Order" and set Name 

- Select Return Transaction 

- De-Select Counter Document flags 

- Select AR Credit Memo for Invoice Document Type 

- Select the created MM Customer Return for Shipment Document Type 

- Optionally create a special Document Sequence 

 

Unfortunately, we cannot do the above steps automatically as this is configuration specific user data. 

Tip: For an example of a set-up, please check GardenWorld in a fresh install or in a newly created Tenant. 
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Appendix B 

Compiere 3.3 – Installation Instructions  



 

 Copyright © 2009 Compiere Inc. – All rights reserved  27 

Compiere 3.3 Installation Instructions   
 
This is for a new installation of Compiere. If you already have installed a previous version of Compiere, please refer to the 
Migration instructions. 
 

  Prerequisites 

- Database Oracle XE, Oracle 10gR2, Oracle 11g or  
  EnterpriseDB Postgres Plus Advanced Server 8.3.  
  Important: It is mandatory to use a Unicode character set 
- Database approved Linux Operating System,  
  Windows 2003 or Windows XP 
- Disk Space: > 5 GB (includes database)  

- Swap Space: > 1GB 
- Memory: > 512 MB - Recommended: > 1 GB  
- TCP/IP connection  
- Network setup with DNS server and a domain.  
  Tip: Do not use IP addresses. 
- Internet access 

 

Hint: Notice that the screenshots in this document refer to the installation on Windows, but the process is the same for 
Linux, except for the paths (e.g. C:\Compiere2 vs. /Compiere2) and the extension of the scripts (.bat vs. .sh) 

  Database Installation 

Install Database – For the instructions on how to install Oracle XE and EnterpriseDB on Windows and Linux please use 
the install guide on the Compiere website http://www.compiere.org/support/installation.php. 

The JDBC driver for EnterpriseDB has been updated to the version that ships with Postgres Plus Advanced Server 8.3. 

  Java Installation 

1. Download and install Sun Java JDK 6 (SDK), update 5 or higher.   
  Important: The Compiere Server requires the JDK (not just JRE). 

2. For installation instructions see the JDK section on this page: http://java.sun.com/javase/6/webnotes/install/index.html  
 

  Download Compiere 

3. Install /Setup Compiere Server (this includes the Client as well) 

1) Download the current version of Compiere: Web Store (for current customers) or free Community Edition. 

2) Extract the .zip file.  The steps shown assume that you extract to the root directory, resulting in a 
COMPIERE_HOME of C:\Compiere2 in Windows or /Compiere2 in Linux. 

3) Verify that the bin directory for your database executables is included in the PATH. Also, if using Oracle XE 
on Linux, run $ORACLE_HOME/bin/oracle_env.sh. 
 
To update the PATH in Windows, right click on My Computer and choose Properties. Then move to the 
advanced tab and click on Environment Variables. Find the PATH variable and click Edit. 

4) Verify that the path to the JAVA_HOME is set up in the Environment Variables. 
 
To update the JAVA_HOME in Windows, right click on My Computer and choose Properties. Then move to 
the advanced tab and click on Environment Variables. Find the JAVA_HOME variable and click Edit. 

5) Execute the script $COMPIERE_HOME/RUN_Setup.  
Tip: if the following window does not display, please ensure that the following are updated. 

 Add the bin folder where you have installed JDK 1.6 at the beginning of the PATH system environment 
variable. 

 Set the JAVA_HOME system variable to the location of your java installation (e.g., „C:\Program 
Files\Java\jdk1.6.0_05‟) 

 Set the COMPIERE_HOME system variable to the path of your Compiere installation (e.g., 
„C:\Compiere2‟) 

http://www.compiere.org/support/installation.php
http://java.sun.com/javase/downloads/index.jsp
http://java.sun.com/javase/6/webnotes/install/index.html
http://www.compiere.com/wstore
http://www.compiere.com/products/download/index.php
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6) Select Database Type 
Oracle XE, Oracle (for 
Standard or Enterprise 
Editions) or PostgreSQL 
(for EnterpriseDB). 

7) For System Password, 
enter the System database 
User password. 

8) For Database Password, 
enter the Compiere 
database user password, 
(e.g. „compiere‟) 

9) For Server Names, i.e., 
Application, Database and 
Mail, use the DNS name of 
the server.  Hint: Do not 

use localhost (127.0.0.1) or 
IP addresses. 

 

10) Enter or update any other 
parameters as necessary. 

11) Select the Help button, for 
information on any field. 

12) Select the Test button to 
check the parameters.  
Tip: The parameters will 
only save after they have 
been verified. 

13) If an entry is unverifiable, it 
will display with a red X.  
Correct the entry and re-
select Test. 

14) Once all fields are verified, 
click the Save button to 
proceed. 
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15) The Compiere Public License Opens. Click “Yes, I understand and Accept” to continue.  

 

16) The following prompt will display describing your new Security Key. Click „Ok‟ to continue. 

 

17) The Next step is to provide the Subscriber Information. Current customers should provide the subscriber 
information (System Name, Email and Password) exactly as it was registered in the Compiere Web Store to 
get a complete list of applications. 
 
Click Check Available Applications to get a list of applications that are available to be installed. 
 
Tip: Community Edition users may leave the fields blank and click “Check available components” to install 
the Community Edition. 
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18) Select the applications that you would like to install. You can include additional applications by using the 
button Add Application. 
 
By default all available applications will be installed. If you do not wish to install one of them you should 
change the action field from “New Install” to “-None-“. Notice that Compiere Core is a Mandatory Prerequisite 
and must be selected. 
 
Select the OK button to continue 

 
 
 

19) Next, read and accept the Compiere Public License agreement.  
Hint: You might get more than one license agreement, depending on the applications that you are installing. 
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20) Then read and accept the Compiere Commercial License agreement.  
  Hint: You might get more than one license agreement, depending on the applications that you are installing. 

 
 

21) After accepting the license agreement the following window will display: 

 

22) Select Start File Installation. 

            Important: At this point, you must be connected to the internet to continue or the installation will not succeed. 



 

 Copyright © 2009 Compiere Inc. – All rights reserved  32 

23) Once the file installation is complete, select Start Create New Database. 

Note: If you already have a Compiere database in your system, you will be presented with a split panel after „Start 
Server Install”. Click the left panel (Start DROP OLD and create NEW Database) if you want to replace the 
existing database with the new database. 

 

 

24) At the prompt select „Yes‟ to Drop the existing Database and create a new database. 

 

             Warning: If you choose to replace the existing database, all data in the existing database will be removed. 

25) Verify that you see a ‟10: ** Finished‟ message at the end of this step. Then a new window should pop-up to 
  do the license validation. 
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26) The Compiere Support window opens. Complete the necessary fields in order to validate your assets. 

Hint: If you only intend to use the Community Edition of Compiere 3.0, you may skip the following steps and go to 
the Application Server section. 
 
Important: For customers with a valid support contract with Compiere, this is a required step to ensure that the 
features associated with the support level are enabled. If you are a customer and do not have a web store login, 
please contact your system administrator or Compiere Support first. If you are not a customer and would like to 
obtain a trial license for the Professional Edition, please Contact Us and request the files for the Professional 

Edition. 

27) Provide the following information exactly as it was registered in the Compiere Web store and click Check  
  License to validate your asset information. 

- System Name (name provided in the web store registration) 

- Registered Email (email address provided in the web store registration) 

- Password (web store password) 
 

 

28) To verify your license, click the “Check License” button. 
 
Tip: Do not click Start Migration. 
Notice that internet access is required to validate the license information. 

http://www.compiere.com/company/contact-us.php
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29) Next, review that your license information has been validated. If you have a trial license for Compiere 
Professional, but you currently don‟t have a license with Compiere, you will see that the license for Standard is 
invalid. This is expected as the trial doesn‟t include Standard and you may ignore the error. 

 

30) After Compiere Professional license has been verified, click the “X” to close the window. 

Note: If you get the error “You do not have an appropriate license to use this feature” when starting the web UI, then 
login to the server and execute utils/RUN_Support to validate again your license and restart the application server. 
When using the Swing client, ensure that your database connection information matches exactly the information in the 
target URL in RUN_Support (including the fully qualified server name) 

31) Close any additional Setup and /or Support windows. 

  Run Application Server 

4. Start the Compiere Application Server 

1) Execute utils/RUN_Server2. 

2) There should be no errors. Check the logs in $COMPIERE_HOME/jboss/server/compiere/log to verify this. 

3) Common problems include ports already in use: 

- 17:41:09,085 ERROR [NamingService] Could not start on port 1099  
java.net.BindException: Address already in use:  
JVM_Bind at java.net.PlainSocketImpl.socketBind(Native Method) 

- There is another program using port 1099; Stop it and restart Run_Server2  
or setup Compiere to use another port in RUN_setup. 
 
Likely port conflicts: 

 80 - Other web server running (or you need privileges under Linux/Unix)  

 8080 – Used by Oracle Database 

 1099 - Often used by IDEs for debugging, or by internet  messengers (Skype, Gtalk, etc.) 
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  Start Compiere 

5. Start the Compiere Client. 

1) Start the Swing client by double clicking on the Compiere shortcut in your desktop or by executing 

RUN_Compiere2 from the $COMPIERE_HOME directory. 
 
Default users and passwords for the sample Garden World application: 

- GardenUser/GardenUser 

- GardenAdmin/GardenAdmin 

- System/System 

- SuperUser/System 

 
 

2) Alternatively, if you have access to the Professional Edition, you can launch the application from the browser by 
using the URL: http://server:port/apps, (e.g. http://mycompany.com:80/apps.)  
Tip: For optimal performance, the Firefox browser is recommended for using the Compiere Web User Interface. 

 

                   Information: For additional information see the Compiere home page http://www.compiere.com. 

http://server:port/apps
http://www.compiere.com/
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Appendix C 

Compiere 3.3 – Application Extensions  
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Compiere 3.3 Application Extensions - Compiere Partners 
 
This section is for Application Extensions in Compiere available as functionality in 3.3 for Partners. This framework will 
allow Partners to create application extensions that include both reference data and code, and can be distributed to their 
customers through Compiere.  
 

  Registration of Application Extensions – Application Provider (Partner) 

Use the steps below to register for Application Extensions: 

1) To register an Application Extension, log a Support Request with Compiere.  

2) Login with the System Administrator role. 

3) Open the Entity Type window (Application Dictionary => Entity Type) and create a new record. 

 

Hint: Be careful not to modify the entities C, D, CPRO or XUOM. 

Important: Complete all the mandatory fields. For entity type, notice that names beginning with “C” and “X” are 
reserved for Compiere and you must use four characters. 
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Comments about optional fields: 

- Version: The version of your extension. Usually 1.0 for the first version. 

- Prerequisite version: The Compiere Core version that is required for this extension, e.g. 3.3.0. You need 
to use the exact text as defined for the entity type D. 

- Prerequisite applications: The entity type of the applications that need to be installed in order to install this 
extension. For example, set it to CPRO if the extension must be applied on top of the professional edition. 

- Classpath: List of additional jar files required for this extension.  

- Model package: Specific model package from the jar files listed in the classpath field. 

 

4) You do not need to enter any information on the Version, Modification, or Migration Step tabs. 

5) Ensure that your System window contains your up to date information for your system and web store 
email/password information. 

6) Click “Register Application” to send your request to Compiere.  
 
Tip: If an entity type with the same name has already been registered you‟ll get an error “Error: Already 
registered: XXXX”. You will have to create a new record with the new entity type. Verify with Compiere that the 
new entity type that you plan to use is available.  
 

7) Click „Ok‟ to start process. 

 
 

8) Leave the defaults in place and click „Ok‟ to continue. 

 

9) At this point the status will be pending approval from Compiere. Please log a support request in our case 
management system requesting the approval of your component. 
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  Creation of Application .car file – Application Provider (Partner) 

Follow the steps below to create the Application.car file: 

1) Make all the application dictionary changes using the entity type that you registered in the previous step. 

2) Generate jar files for the custom code required by your extension. 

3) After having your new Entity Type approved by Compiere; login to Compiere with the System Administrator 
role and query the entity type that you registered in the previous step and click “Create Application File.” 

 
 

4) Click „Ok‟ to start process. 
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5) Provide the directory for the jar file listed in the field classpath. 

 
 

6) The car file will be generated in the COMPIERE_HOME/data directory. The newly generated .car file will have 
a name of compiere_XXXX.car. 

 

Important: The naming convention for .car files has changed, (e.g. compiere_‟CPRO‟.car from 3.0 and 3.1 is now 
compiere_CPRO.car in 3.3, i.e. without quotes in the file name). If a customer unzipps the Compiere installation 
files into the same directory, it is possible to end up with both compiere_‟CPRO‟.car as well as 
compiere_CPRO.car. This in turn will cause Compiere Professional to show up twice in the installation window. To 
avoid this situation, customers will need to manually delete compiere_‟CPRO‟.car and compiere_‟XUOM‟.car from 
COMPIERE_HOME/data directory. These are the only two .car files that Compiere has distributed prior to 3.2. If a 
customer has created any additional .car files prior to 3.2, it is necessary to follow the same procedure for those 
.car files as well. 
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  Installation – Application Consumer (Customer) 

Follow the steps below to install the Application: 

1) After obtaining the car file for the application extension, copy it to the directory COMPIERE_HOME/data. 

2) Execute RUN_Setup (see Appendix A for details on the setup information.) 
 
Important: Be sure to have internet connection available to be able to get the license terms for the application 
extensions that you plan to install. 

3) When you get to the window to select the applications, besides the application extension that you need to 
install, also select the option Reinstall/Migrate for Compiere Core 3.3. 

 
 

4) Then continue with the MIGRATION steps as usual. (See Appendix A for more details.) 
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Appendix D 

Compiere 3.3 – Command Line Scripts   
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Command Line Scripts   
Scripts are provided in the $COMPIERE_HOME/utils/CommandLine directory for experienced Compiere users who would 
like to perform Compiere instance creation and maintenance via command line or using automated scripts 

 

CLInstall 

Purpose: To create a new Compiere installation. When this script is run a new Compiere instance is created on the 
database specified via configuration file. Please note that existing Compiere database instance is dropped and a fresh new 
Compiere instance is created when this script is run. 

The script validates the components that can be installed against Compiere License server and hence need to be 
connected to internet while running and have the appropriate license to allow you to install the components. The script also 
updates the License information after the instance is created. 

All the component .car files present in $COMPIERE_HOME/data will be installed 

 

1) Environment Variables $COMPIERE_HOME, $JAVA_HOME need to be set. 

2) The configuration parameters to CLInstall are provided via a configuration file. A template CLConfiguartionTemplate is 
provided in the same directory, which you can make a copy and edit the configuration parameters for your specific 
installation. All the parameters have one to one correspondence with the parameters on the first window that comes up 
when running RUN_setup 

Subscriber information for License validation: CL_SYSTEM_NAME, CL_WEBSTORE_EMAIL, CL_WEBSTORE_PASS 

Homes: CL_COMPIERE_HOME, CL_JAVA_HOME, CL_JAVA_TYPE 

Database: CL_COMPIERE_DB_TYPE, CL_COMPIERE_DB_SERVER, CL_COMPIERE_DB_PORT, 
CL_COMPIERE_DB_NAME, CL_COMPIERE_DB_SYSTEM, CL_COMPIERE_DB_USER, 
CL_COMPIERE_DB_PASSWORD 

Apps Server: CL_COMPIERE_APPS_TYPE, CL_COMPIERE_APPS_SERVER, CL_APPS_SERVER_DEPLOY_DIR, 
CL_COMPIERE_JNP_PORT, CL_COMPIERE_WEB_PORT 

SSL Settings: CL_COMPIERE_SSL_PORT, CL_COMPIERE_KEYSTOREPASS 

Mail: CL_MAIL_SERVER, CL_ADMIN_EMAIL, CL_MAIL_USER, CL_MAIL_PASSWORD 

 

3) Running:  

CLInstall takes in the configuration file as a parameter.  
Sample Usage: >CLInstall.bat CLConf.bat 

Errors while running the script are displayed onto the console window and are also written to log files within the same 
directory. 

 

CLMigrate 

This is very similar to CLInstall.bat except that it performs the migration of a Compiere instance instead of dropping and 
recreating a new instance.  

 

CLUpdateLicense 

This script can be run to Update the License information. The script can be only run in a successful Compiere installation 
created via RUN_Setup or installation/migration via command line. The script can be edited to provide different subscriber 
information for license validation.  
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The following line in CLUpdateLicense.bat  
"%COMPIERE_JAVA%" %COMPIERE_JAVA_OPTIONS% -cp %CLASSPATH% com.compiere.client.UpdateLicense 

can be be changed as follows to pass in the subscriber information 
"%COMPIERE_JAVA%" %COMPIERE_JAVA_OPTIONS% -cp %CLASSPATH% com.compiere.client.UpdateLicense --
sysname xxx --email xxx --password xxx 

 

If the parameters are not specified, the subscriber information at the time of installation will be used to update the Licenses 
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